
Chapter 1

Introduction to  
Blender Interface

 Learning Objectives 
 After completing this chapter, you will be able to:
• Understand the Blender interface components
• Use controls for creating or modifying objects
• Use hotkeys in Blender
• Customize the Blender layout
• Customize the colors of the scene components
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Figure 1-1  Starting Blender 2.79 using the taskbar

Figure 1-2  The Blender 2.79 splash screen
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Figure 1-3  The menu displayed 

Figure 1-4  Five different components of Blender interface

Figure 1-5  The Info Editor 

Figure 1-6  The Editor Type 
drop-down

Figure 1-7  The Screen Layout 
drop-down
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Figure 1-8  The Engine 
drop-down

Figure 1-9  The 3D View Editor 



Introduction to Blender Interface				            1-5                                                               

Figure 1-10  The Properties 
Region

Figure 1-11  The view components 
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Figure 1-13  The View menuFigure 1-12  The four views

 

Figure 1-14 The Mode 
drop-down

Figure 1-15  The Outliner
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Figure 1-16  The Display 
drop-down

 

Figure 1-17  The Properties Editor
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Figure 1-18  The Timeline

Figure 1-19  The File Browser

     

Figure 1-20  The Text Editor
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Figure 1-21  The Graph Editor

Figure 1-22  The Video Sequence Editor
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Figure 1-23  The Movie Clip Editor

Figure 1-24  The Dope Sheet 

Figure 1-25  The NLA Editor 
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Figure 1-26  The Logic Editor 
  

Figure 1-27  The Node Editor 
 . 

Figure 1-28  The UV/Image Editor 
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Figure 1-29  Resizing the 
editors

Figure 1-30  Double-headed arrow 
on the splitter widget

Figure 1-31  The menu 
displayed

Figure 1-32  Splitting the editor 
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Figure 1-33   Joining the editors 
 

Figure 1-34  The Blender User Preferences dialog box 
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Figure 1-35  The scene displayed Figure 1-36  The Undo History 
 menu

Figure 1-37  The modified scene
Figure 1-38  The modified 
menu

Figure 1-39  The Repeat History 
menu



Introduction to Blender Interface				            1-15                                                               

Figure 1-40  The Blender User Preferences dialog box 

Figure 1-41  The Mode pie menu Figure 1-42  The Shading pie menu

 

Figure 1-43  The View pie menu Figure 1-44  The Pivot pie menu
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Figure 1-45  The options in 
the Help menu

  

Figure 1-46  The Blender Reference Manual window



Chapter 2
Working with Mesh 

Primitives
 Learning Objectives 
 After completing this chapter, you will be able to:
• Understand viewport navigation controls
• Understand selection techniques
• Understand the Object and Edit modes
• Create and edit mesh primitives
• Understand the proportional editing 
• Change the object color and the background color of a scene
• Render a still image
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. 

Figure 2-1  The cascading menu displayed

Figure 2-2  Various parameters in 3D View Editor
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Figure 2-3  The Select  
menu

Figure 2-5  The Snap menuFigure 2-4  The cascading menu displayed

  

Figure 2-6  The Snap Element 
drop-down

Figure 2-7  The Snap Target 
drop-down and a button added

Figure 2-8  The Snap 
Target drop-down
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Figure 2-9  The mesh primitives available in Blender 

Figure 2-10  The Add UV 
Sphere panel
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Figure 2-11  The objects copied using the Duplicate 
and Duplicate Linked tools

Figure 2-12  The cascading menu displayed
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Figure 2-13  Choosing Group from the 
cascading menu displayed

Figure 2-15  The Move to Layer menu Figure 2-14  Various layer buttons 

Figure 2-17  Faces extruded using the Individual 
Faces and the Region option

Figure 2-16  Various extrude options in 
the cascading menu
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Figure 2-18  Upper face of a cylinder with various bevel amount types

Figure 2-19  The subdivision of edges 
with Smoothness = 0 

Figure 2-20  The subdivision of edges 
with Smoothness = 0.5

Figure 2-22  The Proportional editing 
mode drop-down

Figure 2-21  The Proportional Editing 
Falloff drop-down
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Figure 2-24  The Color Picker windowFigure 2-23  The Object Color check box 
selected

Figure 2-25  The Horizon Color swatch 
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Figure 2-26  The model of a TV unit

Figure 2-27  Choosing the New button Figure 2-28  The Object Color check box 
in the Options Panel 
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Figure 2-29  The back of the TV unit

	

Figure 2-30  The TV1 aligned
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Figure 2-31  The TV Screen aligned

Figure 2-32  The Top1 aligned
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Figure 2-33  The Groups panel

Figure 2-34  The base aligned
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Figure 2-35  The cylinder aligned

Figure 2-36  The Cylinder001 moved
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Figure 2-37  All the copies of cylinder aligned

	 X: 1.89		  Y: 2

Figure 2-38  The side aligned
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Figure 2-39  The drawer aligned

  
                                                                                                                                                              

Figure 2-40  All the copies of side and drawer aligned
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Figure 2-41  The handle and its copies aligned

Figure 2-42  The shelfbottom aligned
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Figure 2-43  The shelfside aligned

Figure 2-44  The copies of shelfside aligned
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Figure 2-45 The shelftop aligned

Figure 2-46  The Horizon Color swatch 
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Figure 2-47  The dining table set

Figure 2-48  The modified cube displayed
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Figure 2-49  All the corner edges deselected

Figure 2-50 The tabletop subdivided
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Figure 2-51  Four corner edges selected

Figure 2-52 The tabletop smoothened at the corners
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Figure 2-53  The leg displayed

Figure 2-54  The face of leg beveled
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Figure 2-55  The bottommost face extruded

Figure 2-56  The bottommost face extruded
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Figure 2-57  The selected face scaled

.
Figure 2-58  The bottommost face extruded
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Figure 2-59  The edge loop created Figure 2-60  Four edge loops created

Figure 2-61  The edge selected Figure 2-62  The edges in the ring scaled

Figure 2-63 The bottommost edge 
loop scaled 



2-26  			    Blender 2.79 for Digital Artists 

Figure 2-64  The leg and its copies aligned

Figure 2-65  The table displayed
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Figure 2-66  The chair modified

Figure 2-67  The edge added to chair
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Figure 2-68  Three more edges added to chair

Figure 2-69  The two faces selected
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Figure 2-70  The two faces extruded

Figure 2-71  The back aligned
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Figure 2-72  The selected edge Figure 2-73  The back subdivided

Figure 2-74  The back001 aligned

Figure 2-75  The copies of back001 aligned
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Figure 2-76  The back007 aligned Figure 2-77  The copies of back007 aligned

Figure 2-78  Four faces are selected

Figure 2-79  Selected faces extruded
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Figure 2-80  Selected edge rings subdivided

Figure 2-81  Selected vertices of chair
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Figure 2-82  Vertices of chair moved

  

Figure 2-83  Center vertices of top of chair 
selected and moved 

Figure 2-84  Center vertices of two legs 
selected and moved 
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Figure 2-85  Center vertices of back selected and moved 

Figure 2-86  Top vertices of back 
selected and moved Figure 2-87 The chair displayed

Figure 2-88 Dining table set
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Figure 2-89  The center table

Figure 2-90  The house model



Chapter 3

Working with Curve 
Primitives

 Learning Objectives 
 After completing this chapter, you will be able to:
• Use Bezier curve primitives
• Use NURBS curve and NURBS surface primitives
• Modify Bezier, NURBS curve, and NURBS surface primitives
• Create and modify text 
• Add background image
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Figure 3-1  The Bezier and Circle primitives and their elements  

Figure 3-2  The Handle 
menu displayed

Figure 3-3  Choosing Bezier from the cascading menu 
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Figure 3-5  Various panels in the 
Properties Editor

Figure 3-4  The Specials 
menu displayed

Figure 3-6  The Nurbs Curve, Nurbs Circle, and Path primitives
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Figure 3-7  Various panels in Properties 
Editor

Figure 3-8  All the Nurbs surfaces displayed
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Figure 3-9  Various panels in 
Properties Editor
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Figure 3-10  The freehand curve drawn Figure 3-11  The parameters 
in Toolshelf

              

Figure 3-12  Freehand curve drawn after setting the parameters 
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Figure 3-13  Various panels in 
Properties Editor
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Figure 3-14  The Properties Region Figure 3-15  The Background Images panel on 
choosing the Add Image button
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Figure 3-17  The Background Images 
panel on adding the clip

Figure 3-16  The Background Images panel on 
adding the image

Figure 3-18  The wallpiece model
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Figure 3-19  The Not Set area in the 
Background Images panel

 

Figure 3-20  The selected image in ortho views

Figure 3-21  The design moved Figure 3-22  The control points and 
handles moved
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. 	
                                                                            

Figure 3-23  The Specials menu Figure 3-24  A control point added

Figure 3-25  The control point and 
handles moved

Figure 3-26  The end control point 
selected

Figure 3-27  The end control point and 
handles moved

Figure 3-28  The control points added 
and handles moved
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Figure 3-30  Control points and handles 
of design.001 moved

Figure 3-29  The design.001 rotated 
and moved down

     

Figure 3-31  The design.002 moved  Figure 3-32  The shape of design.002 
changed  

Figure 3-33  The design003 placed
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Figure 3-34  The hook aligned

Figure 3-35  Control points of center_part displayed
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Figure 3-36  Selected control points 
of center_part

Figure 3-37  Selected control points of 
center_part moved down

Figure 3-39  Selected Control points 
of center_part moved up

Figure 3-38  Selected Control points of 
center_part

 
. 

Figure 3-40  design converted into 
3D shape

Figure 3-41  All the 2D curves 
converted into 3D shape



Working with Curve Primitives		        3-15

 		        				     
     

Figure 3-42  The logo

Figure 3-43  The reference image displayed with reduced opacity
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Figure 3-44  The outer_curve placed Figure 3-45  The control points and 
handles moved

Figure 3-46  The outer_curve extended
Figure 3-47  The Set 
Handle Type menu

	

Figure 3-48  The control point and its 
handle moved

Figure 3-49  The two end control  points 
and their handles moved
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Figure 3-50  The last control point placed 
near to the first control point

Figure 3-51  The Cyclic check box selected 
in the Active Spline panel

Figure 3-52  The last control point and 
first control point joined



3-18				               Blender 2.79 for Digital Artists 

Figure 3-53  The last and the first control 
points and handles placed

Figure 3-54  The outer_curve filled with 
grey color

Figure 3-55  The color of outer_curve 
changed

Figure 3-56  The inner_curve created Figure 3-57  The inner_curve
filled with color
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Figure 3-58  The inner_curve.001 and 
outer_curve.001 placed

Figure 3-59  The ishape1 positioned Figure 3-60  The four control points added 
to ishape1

. 

Figure 3-61  The added control points moved Figure 3-62  The changed shape of 
ishape1
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Figure 3-64  The changed color of 
ishape1

Figure 3-63  The ishape1 filled with 
grey color

Figure 3-65  The ishape2 placed on the 
reference image

Figure 3-66  The ishape3 placed on the 
reference image

Figure 3-68  The logotext moved to right of the 
reference image 

Figure 3-67  The text created
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Figure 3-69  Various panels in Properties Editor
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Figure 3-70  The logotext with font and style changed

Figure 3-71  The text_curve modifed Figure 3-72  The menu displayed

Figure 3-73  The shape of logotext changed Figure 3-74  The logotext aligned
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Figure 3-75  Choosing the visibility icon 
from the Outliner

Figure 3-76  All the shapes of logo

      		        			                      
                                   

Figure 3-77  The rhino line art

                                                   

 

Figure 3-78  The reference image displayed 
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Figure 3-79  The curve drawn Figure 3-80  The selected control points

Figure 3-81  The lineart created

                                                                                                                                                                             	
                       

Figure 3-82  The wall design model
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Figure 3-83  The wall design model



Chapter 4
Working with Modifiers

 Learning Objectives 
 After completing this chapter, you will be able to:
• Use modifiers 
• Understand the types of modifiers
• Create complex objects using modifiers
• Understand the pivot point alignment
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Figure 4-1  The Pivot 
drop-down

Figure 4-2  The Set Origin 
menu

 

 

Figure 4-3  Modifiers displayed for a mesh primitive
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Figure 4-4  Modifiers displayed for a curve primitive

Figure 4-5  The parameters for the Array modifier
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Figure 4-6  The Array modifier added to a cube

Figure 4-7  The parameters for the Bevel 
modifier

Figure 4-8  The Bevel modifier added 
to a cube
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Figure 4-9  The parameters for the Boolean 
modifier

Figure 4-10  The Boolean operation performed  
using various options

Figure 4-11  The parameters for the Build modifier
Figure 4-12  The Build modifier added 
to a cube

 

Figure 4-13  The parameters for the Mirror modifier
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Figure 4-15  The Mirror modifier added to an 
object using the mirror object

Figure 4-14  The Mirror modifier added to 
an object using its own pivot point and axis

Figure 4-16  The parameters for the 
Subdivision Surface modifier

Figure 4-17  The Subdivision Surface 
modifier added to a cube



Working with Modifiers	        4-7

Figure 4-18  The parameters for the 
Remesh modifier

Figure 4-19  The Remesh modifier added using 
options in the Mode drop-down

Figure 4-20  The parameters for the Decimate modifier
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Figure 4-21  The parameters for the 
Multiresolution modifier

Figure 4-22  The Multiresolution modifier 
added to a cube

Figure 4-23  The parameters for the Triangulate 
modifier

Figure 4-24  The Triangulate modifier 
added to a cube
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Figure 4-25  The parameters for the Wireframe 
modifier

Figure 4-26  The Wireframe modifier added 
to a torus

 

Figure 4-27  The parameters for the Curve 
modifier

Figure 4-28  The Curve modifier added 
to the cubes
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Figure 4-29  The parameters for the Laplacian 
Smooth modifier

Figure 4-30  The parameters for the Lattice 
modifier

Figure 4-31  The Lattice modifier added 
to a cone

Figure 4-32  The parameters for the Smooth 
modifier

Figure 4-33  The Smooth modifier added 
to an icosphere
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Figure 4-34  The parameters for the 
Shrinkwrap modifier

Figure 4-35  The Shrinkwrap modifier 
added to a torus

Figure 4-36  The parameters for the 
Simple Deform modifier

Figure 4-37  The Simple Deform modifier added 
to a cube
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Figure 4-38  The parameters for the Warp 
modifier

Figure 4-39  The Warp modifier added 
to a plane

.

Figure 4-40  The parameters for the Wave 
modifier

Figure 4-41  The Wave modifier added 
to a plane
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Figure 4-42  The model of a 
hanging lamp 

Figure 4-43  The lamp cover scaled

Figure 4-44  Selected vertices of lamp cover
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Figure 4-45  Selected vertices of lamp cover scaled

Figure 4-46  Topmost vertex moved
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Figure 4-47  Topmost edges selected

 

Figure 4-48  Selected edges subdivided Figure 4-49  Selected edges subdivided
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Figure 4-50  Hole created at the top of lamp 
cover

Figure 4-51  Bottommost edges selected

Figure 4-52  Hole created at the bottom of 
lamp cover

Figure 4-53  The parameters for the 
Wireframe modifier

Figure 4-54  The lamp cover with default settings 
of the Wireframe modifier

Figure 4-55  The lamp cover with changed settings 
of the Wireframe modifier
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Figure 4-56  Color of lamp cover and 
lamp cover 001 changed

Figure 4-58  The hook modifiedFigure 4-57  The changed shape of hook

Figure 4-59  The model of a flower
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Figure 4-60  The plane created in the view

Figure 4-62  The petal shape createdFigure 4-61  The petal subdivided
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Figure 4-63 Vertices of petal moved in Z direction

Figure 4-64  The parameters for the Multiresolution modifier
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Figure 4-65 The petal subdivided

Figure 4-66  The 3D Cursor aligned
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Figure 4-67  Pivot point of petal shifted Figure 4-68  The petal tilted

Figure 4-69  The Apply menu

 

Figure 4-70  The Empty object in all the views
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Figure 4-71  The parameters for the Array 
modifier

.

Figure 4-72  Second petal created Figure 4-73  The flower created
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Figure 4-74  The Empty moved along Y axis

Figure 4-75 The ovary aligned in all the views
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Figure 4-76  The Ovary scaled and moved Figure 4-77  Color of petal and ovary changed 

	

Figure 4-78  Model of a sofa set

Figure 4-79  Side view of a fruit 
basket Figure 4-80  Top view of a fruit basket



Chapter 5
Digital Sculpting

 Techniques
 Learning Objectives 
 After completing this chapter, you will be able to:
• Understand Sculpt Mode
• Understand types of brushes and strokes
• Understand the Spin tool
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Figure 5-2  The options in the 
Brush panel

Figure 5-1  Various panels in the 
Tools tab

Figure 5-3  The Flyout displaying various brush types
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Figure 5-4  A blurred black circle 
displayed

Figure 5-5  Dragging the cursor 

Figure 5-6  The Sculpt 
Plane drop-down Figure 5-7  The Stroke panel

Figure 5-8  The Stroke 
Method drop-down
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Figure 5-9  The Curve panel
  

Figure 5-10  The Dyntopo 
Figure 5-11  The Dyntopo panel on 
selecting the Dyntopo check box

Figure 5-12  The Symmetry/Lock panel
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Figure 5-14  Various panels in the 
Options tab

Figure 5-13  The History panel

Figure 5-15  The sculpted candle
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Figure 5-16  The candle displayed Figure 5-17  Applying the stroke in the 
Front Ortho view

Figure 5-18  Top circular edge smoothened Figure 5-19  Bottom circular edge smoothened

Figure 5-20  Strokes applied on the top 
face of candle

Figure 5-21  Strokes applied on the top 
circular edge of candle
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Figure 5-22  Strokes applied on candle

Figure 5-23  The Flyout displayed on clicking the current brush type image

Figure 5-24  Adjusting the view of candle 
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Figure 5-25  Wick of candle created Figure 5-26  Color of candle changed

Figure 5-27  The sculpted pot (view 1) Figure 5-28  The sculpted pot (view 2)

Figure 5-29  The Not Set area in 
the Background Images panel
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Figure 5-30  The selected image in ortho views

Figure 5-31  The rotated plane
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Figure 5-32  Selected vertices of pot Figure 5-33  Two vertices of pot placed

Figure 5-34  The vertex placed Figure 5-35  The profile created

Figure 5-36  Two vertices of pot joined Figure 5-37  Selecting all the vertices of pot
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Figure 5-38  The pot created Figure 5-39  Smoothness of pot increased

Figure 5-40  The parameters of the 
Multiresolution modifier 

Figure 5-41  The pot smoothened

Figure 5-42  Applying the stroke Figure 5-43  The stroke on pot
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Figure 5-44  Second stroke at the bottom 
of first stroke

Figure 5-45  Strokes applied in the Right 
Ortho view

Figure 5-46  Dots created on pot

 

Figure 5-47  Stroke applied on the top 
face of pot

Figure 5-48  Strokes applied on the top 
face of pot
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Figure 5-49  Strokes applied on pot

Figure 5-51  Design created on 
pot (view 2)

Figure 5-50  Design created on 
pot (view 1)

Figure 5-52  Color of pot 
changed
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Figure 5-53  Model of a sculpted mug	

Figure 5-54  Model of a sculpted photoframe



Chapter 6

Working with 
Materials - I 

 Learning Objectives 
 After completing this chapter, you will be able to:
• Understand the Blender Render and Cycles Render engines
• Create, assign, modify, and delete materials
• Apply textures to the object
• Apply multiple materials to the object
• Apply multiple textures to the object
• Create background for the scene
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Figure 6-1  The Engine 
drop-down

Figure 6-2  Modified Properties Editor on 
choosing the Material button

Figure 6-3  New material created in Properties 
Editor

 



Working with Materials - I	        6-3

Figure 6-4  Preview of rendered edges of the object Figure 6-5  Preview of render on choosing 
the Volume button 

Figure 6-6  Preview of render on choosing the 
Halo button Figure 6-7  Parameters added to the Diffuse panel   



6-4				               Blender 2.79 for Digital Artists 

Figure 6-8  Default parameters in Properties 
Editor for the Cycles Render engine

Figure 6-9  Modified Properties Editor for the 
Cycles Render engine

Figure 6-10  The options in the Surface 
drop-down
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Figure 6-11  Diffuse BSDF appiled 
to an object

Figure 6-12  Transparent BSDF appiled 
to an object

Figure 6-13  The Viewport 
Shading drop-down Figure 6-14  The Render button in the Render panel
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Figure 6-15  The Glass BSDF and Diffuse BSDF 
shaders and their parameters in Properties Editor

Figure 6-16  Rendered image of a sphere 
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Figure 6-17  The Diffuse BSDF and Brick Texture 
shaders and their parameters in Properties Editor

Figure 6-18  The rendered image

Figure 6-19  The Paper Sky check box 
in the World panel 

Figure 6-20  The Horizon check box in the 
Influence panel 
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Figure 6-21  Rendered image of a scene

Figure 6-22  The Surface panel modified

Figure 6-23  The flyout displayed

.
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Figure 6-24  Rendered image of the scene

Figure 6-25  The UV Sphere with two materials applied 
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Figure 6-26  Modified Properties Editor Figure 6-27  Various panels and the Type 
drop-down in Properties Editor

Figure 6-28  The Type drop-down  
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Figure 6-29  The Coordinates drop-down Figure 6-30  The Projection drop-down

 

Figure 6-31  The Image panel Figure 6-32  Modified Image panel

Figure 6-33  The Source drop-down Figure 6-34  The Color Space drop-down



6-12				               Blender 2.79 for Digital Artists 

Figure 6-35  Dot buttons in various panels

Figure 6-36  The flyout displayed 
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Figure 6-37  The Water surface

Figure 6-38  The c06_tut1_start file 
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Figure 6-39  Selected check boxes in the World panel

Figure 6-40  The parameters of the Displace modifier
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Figure 6-41  Hanging lamp with material 

Figure 6-42  The c06_tut1_start file
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Figure 6-44  The modified Surface panelFigure 6-43  Choosing Mix Shader from 
the Surface drop-down

Figure 6-45  The rendered image 
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Figure 6-46  The rendered image 

Figure 6-47  The Surface panel for 
the Transparent BSDF shader

. 

Figure 6-48  The rendered image 

Figure 6-49  Parameters related 
to Color Ramp

Figure 6-50  Position of second 
color stop changed
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Figure 6-51  The model of a tea cup with copper material 
and a floor with a texture

Figure 6-52  Scene with materials and textures applied 



Chapter 7

Working with 
Materials - II

 Learning Objectives 
 After completing this chapter, you will be able to:
• Use Node Editor to create various materials
• Use Node Editor to apply various textures
• Use the Vertex Paint mode
• Understand UV unwrapping techniques
• Use the Texture Paint mode
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Figure 7-1  Choosing Compositing 
from the Screen Layout drop-down

Figure 7-2  The Compositing layout
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Figure 7-3  The Editor Type drop-down

	                                  
	

Figure 7-4  Components of Node Editor
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Figure 7-5  The Material and Output nodes added to Node 
Editor with the Material node selected

Figure 7-6  The Add menu Figure 7-7  The cascading menu Figure 7-8  The cascading menu
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Figure 7-9  The multicolored cube

Figure 7-12  The options in 
the Brush panel

Figure 7-10  The panels 
in the Tools tab

Figure 7-11  The panels 
in the Options tab
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Figure 7-13  The flyout displayed

Figure 7-14  The Shading and 
UVs panel in Toolshelf 

Figure 7-15  Options in the UV 
Mapping drop-down 
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Figure 7-16  The New Image window

  

Figure 7-17  Textured center table and 
glass

Figure 7-18  The c07_tut1_start file 
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Figure 7-19  Connected Image Texture node and 
Diffuse BSDF node displayed

Figure 7-20  Node flow for the wood material

Figure 7-21  The rendered image
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Figure 7-22  Node flow for metal material

Figure 7-23  The rendered image

 

Figure 7-24  The UV Mapping drop-down Figure 7-25  The Smart UV Project window
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Figure 7-26  UVs of glass

Figure 7-27  The New Image window
Figure 7-28  The Mode 
drop-down 

Figure 7-29  Painted UVs of glass
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Figure 7-30  Connected Image Texture node and 
Diffuse BSDF node 

Figure 7-31  Textured flower using vertex paint

Figure 7-32  The c07_tut2_start file dispalyed
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Figure 7-33  Strokes applied on petal

Figure 7-34  Choosing F Mix from the flyout

Figure 7-35  Strokes applied on petal Figure 7-36  Strokes applied on petal
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Figure 7-37  Strokes applied on petal Figure 7-38  Strokes applied on ovary

 

Figure 7-39  Choosing Compositing 
from the Screen Layout drop-down

Figure 7-40  Attribute node added to Node area

Figure 7-41  Vertex paint on ovary visible 
in the rendered image

Figure 7-42  Vertex paint on petal visible 
in the rendered image
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Figure 7-43  The model of a sofa set with velvet material 
and a floor with a texture

 
							                            	   

Figure 7-44  Textured bowl



Chapter 8

Lights and Cameras
 Learning Objectives 
 After completing this chapter, you will be able to:
• Understand various types of lamps
• Understand mesh lighting
• Understand light portals
• Understand camera
• Constrain a camera to an object 
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Figure 8-2  Various panels in Properties Editor
Figure 8-1 Choosing Point from the 
Add menu

Figure 8-3  Point lamp placed in the scene Figure 8-4  The Rendered image
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Figure 8-5  Sun lamp placed in the scene Figure 8-6  The rendered image

Figure 8-7  Spot lamp placed in the scene Figure 8-8  The rendered image

Figure 8-10  The rendered imageFigure 8-9  Area lamp placed in the scene

Figure 8-11  Scene without light portal Figure 8-12  Scene with light portal
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Figure 8-13  The Emission shader 
chosen in the Surface drop-down 

Figure 8-14  The Emission node connected to 
the Material Output node 

Figure 8-15  The rendered image of 
the scene with Strength=10

Figure 8-16  The rendered image of 
the scene with bluish tint
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Figure 8-17  Various panels in Properties Editor .
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Figure 8-18  The Add Object Constraint drop-down

Figure 8-19  The Track To panel in Properties Editor Figure 8-20  Camera constrained to lamp

Figure 8-21  The options in the View menu 
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Figure 8-22  The illuminated interior scene

Figure 8-23  The c08_tut1_start file
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Figure 8-24  The point lamp aligned

Figure 8-25  The wall light2 aligned
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Figure 8-26  The hanging lights aligned

Figure 8-27  The rendered image



8-10				               Blender 2.79 for Digital Artists 

Figure 8-28  The spot light1 aligned

Figure 8-29  The rendered image
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Figure 8-30  Other spot lights aligned

Figure 8-31  The illuminated exterior scene
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Figure 8-32  The c08_tut2_start file

Figure 8-33  The sunlight rotated
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Figure 8-34  The rendered image 

Figure 8-35  The spot light aligned
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Figure 8-36  The scene illuminated with spot lights

Figure 8-37  Wall illuminated by spot lamps 



Chapter 9

 Basics of Rigging 
and Animation 

 Learning Objectives 
 After completing this chapter, you will be able to:
• Understand the concept of rigging
• Apply constraints
• Work with Timeline, Dope Sheet, and Graph Editor 
• Create path animation
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Figure 9-1  The Add Object Constraint drop-down

Figure 9-3  The cube with the Track 
to constraint applied

Figure 9-2  The cube and sphere

Figure 9-4  The parts of armature
Figure 9-5  The Mode 
drop-down
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Figure 9-6  Bones added to armature

Figure 9-7  The Animation layout

Figure 9-8  The Timeline
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Figure 9-9  The Keyframe Type  
drop-down

Figure 9-10  The Keying Set  
drop-down

Figure 9-11  The Graph Editor

Figure 9-12  The Dopesheet
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Figure 9-13  The rig of a cartoon animal

Figure 9-14  The c09_tut1_start file 
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Figure 9-15  The Armature aligned

Figure 9-16  Extruded Armature aligned
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Figure 9-17  Extruded Armature aligned

 

Figure 9-18  Bone.003 aligned 
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Figure 9-19  The bodybone aligned 

Figure 9-20  Copy of bone chain aligned
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Figure 9-21  All bone chains aligned

Figure 9-22  All interconnected bones 
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Figure 9-23  The text and cart at frame 55

Figure 9-24  The c09_tut2_start file 
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Figure 9-25  Selected keyframes at frame 0

Figure 9-26  The Add Object Constraint drop-down
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Figure 9-27  The Animation layout

Figure 9-28  Selected keyframes in Dopesheet
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Figure 9-29  The model of a table lamp Figure 9-30  The rig of a table lamp



Chapter 10 

Rigid Body Dynamics
 Learning Objectives 
 After completing this chapter, you will be able to:
• Create active and passive rigid bodies
• Simulate various physical effects
• Understand rigid body constraints
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Figure 10-1 Various buttons in the Enable 
physics for area

Figure 10-2 Various panels in Properties 
Editor 

   

Figure 10-3 The Shape drop-down Figure 10-4 The Source drop-down 
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Figure 10-5  The Cloth Preset drop-down

Figure 10-6  The Type drop-down

 

Figure 10-7  The Type drop-down
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Figure 10-8  Balls falling from bowl at frame 55

Figure 10-9  The c10_tut1_start file 

Figure 10-10  Cloth simulation at frame 35 Figure 10-11  Cloth simulation at frame 100
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Figure 10-12  The c10_tut2_start file 

Figure 10-13  The scene with sliders 
and a ball

Figure 10-14  Ball at frame 504
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Figure 10-15  The scene with two 
assemblies, balls, and a bowl

Figure 10-17  Simulation at frame 45Figure 10-16  Simulation at frame 25



Chapter 11
Working with Particles

 Learning Objectives 
 After completing this chapter, you will be able to:
• Understand particle system
• Understand various simulation techniques
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Figure 11-1  The Properties Editor on 
choosing the Particles button 

Figure 11-2  Properties Editor on 
choosing the New button 

Figure 11-3  Particles emitted from the 
cube on choosing the Verts button

Figure 11-4  Particles emitted from the 
cube on choosing the Faces button



Working with Particles	        11-3

Figure 11-5  Particles emitted from the 
cube on choosing the Volume button

Figure 11-6  Particles emitted from the 
cube on choosing the Grid button

 

Figure 11-7  The Orientation 
drop-down

Figure 11-8  The Angular Velocity 
drop-down
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Figure 11-9  Particles emitted from the 
cube on choosing the No button

Figure 11-10  Parameters in the Physics 
panel on choosing the Newtonion button

Figure 11-11  Parameters in the Physics 
panel on choosing the Keyed button
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Figure 11-12  Parameters in the Physics 
panel on choosing the Boids button

Figure 11-13  Parameters in the Physics 
panel on choosing the Fluid button

Figure 11-14  The parameters in the Render 
panel
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Figure 11-15  Rendered halo particles 

Figure 11-17  The parameters in the 
Render panel 

Figure 11-16  The particles emitted 
as lines
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Figure 11-18  Smoke simualtion at frame 80

Figure 11-19  The c11_tut1_start file
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Figure 11-20  Values in the Transform panel Figure 11-21  Values in the Transform panel

Figure 11-22  The force1 and force2 aligned

Figure 11-23  Values in the Transform panel
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Figure 11-24  The emitter aligned

Figure 11-25  Particles emitted from emitter
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Figure 11-26  Change in number and lifetime of 
particles

Figure 11-27  Spheres of different sizes

Figure 11-28  Parameters in the 
Image Texture node
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Figure 11-29  Node network for smoke material

Figure 11-30  Smoke simulation at frame 80
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Figure 11-31  Snow simulation at frame 100

Figure 11-32  Adjusting the view
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Figure 11-33  Camera Persp view displayed

Figure 11-34  Emitter aligned

		

Figure 11-35  Node network for snow material
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Figure 11-36  wind aligned

Figure 11-37  Rain simulation
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